
WorkBench Software
(and WorkBench Lite Software)

for the 860 DSP, 860 DSPi, 860 DSPh, 860 DSPr, and 8300 FST

Operation Manual











WorkBench Software - Operation Manual
xiv

5. Using the TDM Component ........................................................................................... V-58
TDM Outbox .................................................................................................................... V-59

Sending Packages to an Outbox ................................................................................ V-61
Sending Channel Plans to an Outbox .......................................................................... V-63
Sending Auto-Test Macros to an Outbox ..................................................................... V-65
Sending Locations to an Outbox ................................................................................. V-67
Sending Firmware Upgrades to an Outbox ................................................................. V-69
Sending Option Codes to an Individual Outbox ........................................................... V-71
Sending Local Files to an Outbox ............................................................................... V-73
Sending Configurations to an Outbox.......................................................................... V-75

Task Sheets ..................................................................................................................... V-77
Creating New Task Sheets ......................................................................................... V-77
Entering Tasks Into Task Sheets ................................................................................. V-81
Sending a Task to an Individual Outbox ....................................................................... V-82
Sending a Task to an Individual 860 DSP or 860 DSPi ............................................... V-83
Manually Closing Tasks .............................................................................................. V-87
Showing Closed Tasks ............................................................................................... V-87
Deleting a Task .......................................................................................................... V-88
Deleting a Task Sheet ................................................................................................ V-88
Editing a Task Sheet .................................................................................................. V-89
Archiving a Task Sheet ............................................................................................... V-92
Viewing Archived Task Sheets .................................................................................... V-93
Importing Tasks and Task Sheets ................................................................................ V-94
Exporting Task and Task Sheets ................................................................................. V-97

TDM Reports ................................................................................................................. V-102
Overview .................................................................................................................. V-102
At-Tap Node History ................................................................................................. V-103
Calibration Check .................................................................................................... V-108
House History ........................................................................................................... V-112
Meter Inventory ......................................................................................................... V-116
Set Top Compliance Details ..................................................................................... V-119
Set Top Compliance Summary ................................................................................. V-123
Technician Compliance ............................................................................................ V-126



WorkBench Software - Operation Manual
xv

THIS PAGE LEFT INTENTIONALLY BLANK



WorkBench Software - Operation Manual
xvi

THIS PAGE LEFT INTENTIONALLY BLANK



WorkBench Software - Section I: The Basics
I-1

Section I: The Basics

WorkBench Software
(and WorkBench Lite Software)

for the 860 DSP, 860 DSPi, 860 DSPh, 860 DSPr, and 8300 FST
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Helpful Website

The following website contains general information which may be of interest to you:

http://www.trilithic.com

Trilithic’s website contains product specifications and information, tips, release information,
marketing information, Frequently Asked Questions (FAQs), bulletins and other technical
information. You can also check this website for product updates.

Where to Get Technical Support

Trilithic technical support is available Monday through Friday from 8:00AM to 5:00PM EST.
Callers in North America can dial 1-317-895-3600 or 1-800-344-2412 (toll free).  International
callers should dial 1-317-895-3600 or fax questions to 1-317-895-3613. You can also email
technical support at techsupport@trilithic.com.

For quicker support response when calling or sending email, please provide the following
information:

• Your name and your company name

• The technical point of contact (name, phone number, email)

• The version number of the WorkBench software (this appears in the Help menu About
WorkBench... selection)

• The version number of the Windows software (including any service packs and patches)

• The database that you are using

• A detailed description of the problem you are having, including any error or information
messages

1. General Information
Chapter 1
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How this Manual is Organized

Thank you for choosing Trilithic’s WorkBench Software. This manual is provided with the
WorkBench Software to help the user become better acquainted with the software and to become
productive faster. This manual is divided into the following sections:

• Section I: The Basics - provides Trilithic contact information, describes how this
Operation Manual is structured, provides installation and registration instructions, and
gives an overview of the WorkBench Software and it’s basic features. Before using the
WorkBench Software, it is recommended that the user read this section for an overview of
features, setup, basic commands and other important details.

• Section II: Managing Devices and Data  - provides details on how to connect to the 860
DSP, 860 DSPi, 860 DSPh or 8300 FST as well as how to import and export data to and
from the devices. This section also includes information on how to analyze the data
collected from these devices.

• Section III: Configuration Files - provides information on how to configure Channel
Plans, Locations, Auto-Test Macros, Task Sheets and Text Files.

• Section IV: Managing Configurations  - provides details on how to create configuration
packages for the 860 DSP, 860 DSPi, or 860 DSPh.

• Section V: Trilithic Data Manager (TDM) Component - provides information on how to
configure and use the TDM component of WorkBench to send and receive information to
and from the 860 DSP and 860 DSPi remotely over the internet.
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Conventions Used in this Manual

This manual has several standard conventions for presenting information.

• Connections, Menus, menu options, and user entered text and commands appear in bold.

• Section names, Web and email addresses appear in italics.

A NOTE is information that will be of assistance to you related
to the current step or procedure.

A CAUTION alerts you to any condition that could cause a
mechanical failure or potential loss of data.

A WARNING alerts you to any condition that could cause
personal injury.
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Overview

WorkBench is the Windows-based companion software for 860 DSP series devices and the 8300
FST. It is a Web-linked application that supports and augments the many functions and features of
Trilithic’s 860 DSP Interactive Cable Analyzers and 8300 FST Forward SpeedSweep Transmitter.

The 860 DSP performs most of its functions through Digital Signal Processing technology rather
than dedicated hardware, making it easy to keep the 860 DSP current with changing applications
and conditions. WorkBench lets you install and configure continuous feature updates quickly and
easily. You can also expand the features available to you on your 860 DSPs by purchasing
additional performance options, downloading them from the Trilithic Web site, and installing them
at your convenience.

2. Introduction
Chapter 2

Features

You can use the WorkBench software to do the following:

• Customize your device to meet your specific needs and preferences by configuring the
navigation menus

• Choose and edit channel plans, locations, auto-test macros, and configuration packages

• Set a wide variety of device measurement options, test mode options, and performance
limits for auto-test functions

• Analyze and report on data collected from your device, including performance to user-set
limits such as analog signal amplitudes, digital signal power, signal quality, carrier/noise
ratios, MER and other measures of digital performance, and key return path
measurements

• Identify and download firmware updates and new options from the Trilithic Web site that
can then be stored in WorkBench until it is convenient for you to load them into your device

• Install and configure firmware updates to enhance existing features and add new
capabilities

• Receive announcements of new features and functions, firmware revisions and updates,
new product options, and other performance enhancements by clicking the banner at the
bottom of the WorkBench Navigator window

With WorkBench, you can create the most effective menu structure and set all of your devices to
have uniform features, settings, and configurations. Your technicians won’t have to spend time
reconfiguring or relearning how to use individual units; they can instead get right to work with no
lost effort. You’ll soon see that the WorkBench software is a powerful adjunct to Trilithic’s devices
that makes configuring, maintaining, and customizing any number of devices a snap.
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3. Software Installation
Chapter 3

Once you have made sure that your system meets the minimum requirements, you’re ready to
install the WorkBench software.

Be sure to check the CD for release notes that may affect the
installation and configuration process!

Check with your network or systems administrator if you’re not
sure about your current login account permissions.

WorkBench System Requirements

To install the WorkBench software, your computer must meet the following minimum requirements:

• 200 MHz Pentium-II

• 64 MB RAM

• 100 MB free disk space

• Windows NT 4.0, 2000, XP, or Vista

• Color monitor running at 256 colors or higher, 800 x 600 minimum screen resolution

• Windows-compatible mouse

• Standard 9-pin serial port and/or Ethernet adapter (860 DSP Ethernet interface is optional)

• Trilithic 9-pin to 1/8" stereo connector cable (included)

It is also strongly recommended that you have an Internet connection for using the WorkBench
software’s online feature, which lets you get the latest updates and newest features.

Installation Instructions

To install the WorkBench software, do the following:

1. Depending on the operating system you are installing the WorkBench software on, you may
need to log on as the local administrator.

2. Insert the WorkBench software CD in the appropriate drive.
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3. If you have Autorun enabled for the CD-ROM drive, the WorkBench software setup program
will start automatically. Otherwise, click Start, then click Run, and type [drive]:\setup.exe,
then click OK. (Substitute the appropriate drive path in the command.)

4. If a previous version of the WorkBench software is found the following screen will appear.
Select Yes to remove the previous version of the WorkBench software.

5. The “Preparing to install...” screen appears.

The setup program examines your system for the Microsoft
DAC and Microsoft .NET Framework components before
installation. If either of these components are missing from your
system, the installer will install them for you before continuing
with the WorkBench setup.
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6. After a moment, the “Welcome to the InstallShield Wizard for Trilithic WorkBench” screen
appears. Select the Next> button to continue.

7. The “Destination Folder” screen appears. Enter information on this screen as follows:

Folder: By default, the installation procedure installs WorkBench in the
C:\Program Files\Trilithic\WorkBench\ folder. You can select a different location by
selecting the Browse button.

Select the Next> button to continue.
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8. The “Installation Type” screen appears.

If you want to change the installation settings, select the <Back button; otherwise, select the
Install button.

Select the Full Access radio button if you want the users of this application to have access
to all features including both data and device management. This is the default option and is
recommended for most users.

Select the Limited Access radio button if you want the users of this application to have
access to only those features necessary to perform data management. All features that
assist in device configuration will be inaccessible.

9. When you are satisfied with your entries, click the Next> button. The “Ready to Install the
Application” screen appears.
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10.The WorkBench installation procedure installs the files and the Trilithic WorkBench icon on
your desktop. The “Installing Trilithic WorkBench” screen appears to display the status of
the installation.

11. When installation is complete, the “InstallShield Wizard Completed” screen appears.
Select the Finish button
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4. Registering WorkBench
Chapter 4

Overview

WorkBench is a fully-functional software package and all features of the program are accessible
once the program has been installed and registered.  WorkBench Lite includes the same features
as WorkBench, however the Datalog functions of the program will be automatically disabled 30
after WorkBench Lite is installed.  You can register the software online or by telephone.

Registering Online

To register WorkBench online, perform the following steps:

1. From the Help menu, select Register Online....
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2. The WorkBench Registration Form screen appears. Enter information in the fields as
follows:

First Name: Enter the
registrant’s first name. (Required
field.)

Last Name: Enter the
registrant’s last name. (Required
field.)

Postal / Zip Code: Enter the zip
or postal code. (Required field.)

Country: Select the country from
the drop-down list. (Required
field.)

Address: Enter the first line of
the company address. (Required
field.)

City: Enter the city. (Required
field.)

State / Province: Enter the state
or province. (Required field.)

Telephone: Enter the phone
number. (Required field.)

Email Address: Enter the registrant’s email address. (Required field.)

Company: Enter the company name. (Required field.)

Job Title: Enter the registrant’s title.

Product Key: Enter the product code that accompanied your software. (Required field.)
The product code is located on the back of the WorkBench software’s CD sleeve.

License Key: This display-only field contains the license key that uniquely identifies the
computer on which the software is installed.

Serial Number: Enter the serial number that accompanied your software. (Required field.)
The serial number is located on the back of the WorkBench software’s CD sleeve.
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3. When you are satisfied with your entries, select the Get Activation Code button.
WorkBench connects to a Trilithic server via the Internet and registers the software. The
Registration Confirmation screen shows that the registration was successful. Be sure to
copy the activation code for your records.

The WorkBench software is licensed on a per-machine basis.
Once the software has been registered, any attempt to register
the same product code on additional computers will be
unsuccessful. To move the WorkBench software to a different
computer, please contact Trilithic customer support for
assistance in transferring the license.
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3. The Trilithic Product Registration screen appears.
Enter information in the fields as follows:

Product Key: Enter the product code that
accompanied your software. (This is a required field.)

License Key: This display-only field contains the
license key that uniquely identifies the computer on
which the software is installed.

Registration Key: Enter the registration key you
received from Trilithic. (This is a required field.)

Registering By Phone

If you prefer, you can register WorkBench by phone. This is done by calling Trilithic and obtaining a
registration key for your software, then entering the information in the WorkBench software, as
follows:

1. Call Trilithic from 8:00am to 5:00pm (Eastern time) Monday through Friday at
1-800-344-2412 to request a registration key. Write this key down.

2. From the Help menu, select Register by Phone....
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4. When you are satisfied with your entries, select the Register button. The Trilithic Product
Registration screen appears, confirming the registration.

The WorkBench software is licensed on a per-machine basis.
Once the software has been registered, any attempt to register
the same product code on additional computers will be
unsuccessful. To move the WorkBench software to a different
computer, please contact Trilithic customer support for
assistance in transferring the license.
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5. Guided Tour of WorkBench
Chapter 5

1. Command Menu - This area is contains the commands to access files, change view
settings, connect and retrieve data from devices, arrange open windows, and access
support and help information.

2. Toolbar - This area is used as a shortcut to most commands that are accessible through
the Command Menu.

3. Navigator Window - This area is used to organize and access all of the data created and
managed by the WorkBench software.

1

2

3

4

5

Overview

Once you have installed the WorkBench software, you’re ready to learn your way around. Start
WorkBench by double-clicking the Trilithic WorkBench icon on your desktop.

WorkBench versus WorkBench Lite

WorkBench is a fully-functional software package and all features of the program are accessible
once the program has been installed and registered.  WorkBench Lite includes the same features
as WorkBench, however the Datalog functions of the program will be automatically disabled 30
after WorkBench Lite is installed.  The software online or by telephone, and the upgrade from
WorkBench Lite to WorkBench can be configured at that time.  Refer to Chapter 4: Registering
WorkBench for additional information.
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4. Data Window - This area is used to display channels plans, device data, graphs, and
Internet browser pages.

5. Event Log and Task Window - This area is used to display a log of events that take
place in WorkBench and tasks that need to be completed.

Command Menu

Main Menus

The Command Menu has six basic menus, as described in the following table.

Menu Commands 

File 

Setup new channel plans, locations, macros, task sheets  

(TDM Component Required), text files, configuration packages, 
and connections 

Import and export channel plans, locations, macros, tasks and 
task sheets (TDM Component Required), data logs, and 
screen captures 

Setup printer settings 

Setup general, database and device options 

Exit WorkBench 

View 
Show or hide the toolbar, status bar, navigator, log/tasks, and 
refresh the current view 

Device 

Start the Configuration Wizard, set individual configuration 
settings for each type of device, set the date/time of devices to 
match PC system time, re-boot devices, and apply firmware 
guides to devices 

Data 
Start the Data Collection Wizard for collecting data from 860 
DSPs and start the Data Query Wizard for searching and 
analyzing data collected from 860 DSPs 

Window 
Change the configuration of open windows in WorkBench and 
arrange the WorkBench icons 

Help 

Open help topics, submit online support requests, submit 
online problem reports and comments, check for software 
updates, register WorkBench online or by phone, register the 
TDM Component (TDM Component Required), and view the 
current software version of WorkBench 
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File Menu

Menu Commands 

New 
Setup new channel plans, locations, macros, task sheets, text 
files, configuration packages, and connections 

Close Close the current document 

Save Save the current modified document 

Import 
Import channel plans, locations, macros, task/task sheets, data 
logs, and screen captures 

Export 
Export channel plans, locations, macros, task/task sheets, data 
logs, and screen captures 

Print Prints the active document or screen 

Print Preview Lets the user preview the document that is about to be printed 

Print Setup Setup printer settings 

Options Setup general, database and device options 

Exit Exit WorkBench 
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View Menu

Menu Commands 

Toolbar Show or hide the toolbar 

Status Bar Show or hide the status bar 

Navigator Show or hide the navigator window 

Log Show or hide the event log and task window 

Refresh Refresh the current view 
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Device Menu

Data Menu

Menu Commands 

Data Collection 
Wizard 

Starts the Data Collection Wizard for collecting data from the 
860 DSP & 860 DSPi Field Analyzers 

Data Query Wizard 
Starts the Data Query Wizard for searching and analyzing data 
collected from 860 DSP & 860 DSPi Field Analyzers 

 

Menu Commands 

Configuration 
Wizard 

Starts the device configuration wizard 

860 DSP 

Configure the following settings for the 860 DSP & 860 DSPi 
Field Analyzers; General, Level, Scan, Depth of Modulation, 
CSO/CTB, Forward Sweep, QAM, Web Browser, Network 
Test, Return Test, VoIP, Telemetry Search Set, Navigation 
Menus, and Limits 

860 DSPh 
Configure the following settings for the 860 DSPh Headend 
Analyzer; General, Network, Measurement, SNMP, and Inputs 

860 DSPr 

Configure the following settings for the 860 DSPr Headend 
Analyzer; General, Level, Scan, Scan Limits, Depth of 
Modulation, CSO/CTB, Forward Sweep, QAM, Web Browser, 
Network, Network Test, Return, VoIP, Telemetry Search, FDR, 
and Navigation 

8300 FST 
Configure the following settings for the 8300 FST Forward 
SpeedSweep Transmitter; General and Network 

Set Date/Time Sets the date/time of devices to match PC system date/time 

Re-Boot Re-Boots devices after configuration 

Apply Firmware 
Upgrade 

Applies firmware upgrades to devices 
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Menu Commands 

Cascade Cascades the open windows in WorkBench 

Tile Tiles the open windows in WorkBench 

Arrange Icons Arranges the icons in WorkBench 

 

Window Menu

Help Menu

Menu Commands 

Help Topics Goes to the main help screen 

Submit Online 
Support Request 

Displays the WorkBench online technical support request web 
page 

Submit Online 
Problem Report or 
Comments 

Displays the WorkBench online customer response web page 

Check for Updates Displays the WorkBench software update web page 

Register Online Displays the WorkBench online software registration web page 

Register by Phone 
Displays the WorkBench window for entering a WorkBench 
Software Registration Key that is obtained over the phone 

Register TDM 
Component 

Displays the WorkBench window for entering a Trilithic Data 
Management Registration Key that is obtained over the phone 

About WorkBench 
Displays information about the version of the WorkBench 
software 
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Toolbar Icons

The WorkBench toolbar provides a quick way to access a number of convenient commands
and features.

Icon Description 

 

Start a new channel plan, location, macro, text file, configuration package, or 
connection (same as the File/New command) 

 
Save the current modified document (same as the File/Save command) 

 
Prints the active document or screen (same as the File/Print command) 

 
Show or hide the Navigator Window (same as the View/Navigator command) 

 

Show or hide the Event Log and Task Window (same as the View/Log 
command) 

 
Configure device parameters (context varies based on which type of device is 
selected) 

 
Launches the Trilithic Data Manager (TDM) Report Console. 

 
Collect data from the 860 DSP logs (same as the Data/Data Collection 
Wizard command) 

 
Query saved data logs (same as the Data/Data Query Wizard command) 

 
Group data by Company Name (same as the right-click menu on the Data 
Tab of the Navigator Window) 
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Icon Description 

 

Group data by Operator Name (same as the right-click menu on the Data Tab 
of the Navigator Window) 

 
Group data by Workgroup Name (same as the right-click menu on the Data 
Tab of the Navigator Window) 

 
Group data by Location Name (same as the right-click menu on the Data Tab 
of the Navigator Window) 

 

Group data by Task Information (same as the right-click menu on the Data 
Tab of the Navigator Window) 

 

Group data by Type (same as the right-click menu on the Data Tab of the 
Navigator Window) 

 
Resets all data grouping to default settings (turns off grouping) 

 
Do a primary sort of data by log name (same as the right-click menu on the 
Data Tab of the Navigator Window) 

 
Do a primary sort of data by log type (same as the right-click menu on the 
Data Tab of the Navigator Window) 

 
Sort by log name in ascending order (same as the right-click menu on the 
Data Tab of the Navigator Window) 

 
Sort by log name in descending order (same as the right-click menu on the 
Data Tab of the Navigator Window) 
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The toolbar icon and Help menu item for problem reports and
comments is intended to provide Trilithic with feedback relating
to the stability and function of the WorkBench software. Please
note that this form is not intended to provide technical
support—a reply will not be sent. For technical support, please
follow the steps outlined previously in this manual.

Icon Description 

 

Sort by log date in ascending order (same as the right-click menu on the Data 
Tab of the Navigator Window) 

 
Sort by log date in descending order (same as the right-click menu on the 
Data Tab of the Navigator Window) 

 
Displays the contact screen for problem reports (same as the Help/Submit 
Online Problem Report or Comments command) 
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Navigator Window

The Navigator window is used to organize and access all of the data created and managed by the
WorkBench software.

When WorkBench first starts, the Navigator window appears to the left of the WorkBench screen.

The Navigator Window has four tabs, as described in the following table.

Global Tab
When the WorkBench software opens, the Navigator Window

will default to the  tab as shown to the right.

Tab Description 

 
Displays channels plans, locations, macros, text files, configuration 
packages, and provides a quick link to the application options 

 Displays the various queries and data sets in the WorkBench software 

 Displays the devices that have been set up in the WorkBench software 

 
Links to the Trilithic web site for additional information, notes, bulletins, 
and firmware upgrades 
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From the  tab, the following options are available:

Option Description 

 

Double-clicking this option opens the Application Options 
Window to the General Tab (this is the same as selecting the 
File/Options command) 

Selecting the plus (+) sign next to Application Options will display 
the General, Databases, Devices, and TDM Options (TDM 
Component Required); double-clicking any of these options will 
open the Application Options Window to the selected option tab 
For more information on configuring TDM Options, see  
Section VI: Trilithic Data Manager (TDM) Component 

 

Double-clicking this option or selecting the plus (+) sign next to 
Local Files will display a list of all the text files in WorkBench 
Using this option is described in the Creating and Maintaining 
Text Files Section 

 

The Trilithic Data Manager (TDM) Component is required to use 
this option 
For more information on using this option, see Section VI: 
Trilithic Data Manager (TDM) Component 

 

The Trilithic Data Manager (TDM) Component is required to use 
this option 
For more information on using this option, see Section VI: 
Trilithic Data Manager (TDM) Component 

 

Double-clicking this option or selecting the plus (+) sign next to 
the 860 DSP will display a list of the Packages, Channel Plans, 
Auto-Test Macros, Locations, and Task Sheets (TDM 
Component Required) in WorkBench 
Using this option is described in the Creating and Maintaining a 
Configuration Package Section�For more information on using 
Task Sheets, see Section VI: Trilithic Data Manager (TDM) 
Component 
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Data Tab

The  tab is displayed as shown to the right.

From the  tab the following options are available:

Option Description 

 

Double-clicking this option or selecting the plus (+) sign 
next to  

860 DSP will display the Saved Queries and Query 
Results tree options 

 

Selecting the plus (+) sign next to Saved Queries will 
display all of the queries saved in WorkBench 

Double-clicking any of the saved queries will start the 
Data Query Wizard with the saved query parameters 
already selected 

 

Selecting the plus (+) sign next to Query Results # will 
start the Data Query Wizard if no query is defined 
(same as the Data/Data Query Wizard command) 

Double-clicking any of the query results or selecting the 
plus (+) sign next to Query Results # will display all of 
the data that was returned when the query was 
executed 

Double-clicking on any of the data that was returned 
when the query was executed will display the data in 
the Data Window 
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Devices Tab

The  tab is displayed as shown below.

From the  tab the following options are available:

Option Description 

 

Right-clicking this option will display a menu to create 
a new connection to a 860 DSP or to show offline 860 
DSPs 

Double-clicking this option or selecting the plus (+) 
sign next to 860 DSP will display a list of the 860 
DSPs that are connected to WorkBench; double-
clicking any of 860 DSPs from this list will display a 
list of the Channel Plans, Auto-Test Macros, 
Locations, and Text Files associated with that 860 
DSP 

 

Right-clicking this option will display a menu to create 
a new connection to a 860 DSPh or to show offline 
860 DSPhs 

Double-clicking this option or selecting the plus (+) 
sign next to 860 DSPh will display a list of the 860 
DSPhs that are connected to WorkBench; double-
clicking any of 860 DSPhs from this list will display a 
list of the Channel Plans and Auto-Test Macros 
associated with that 860 DSPh 
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Online Tab

The  tab will allow WorkBench to be connected to the
Internet, and once connected, provides up-to-date access to
information and tasks such as checking for software and
firmware updates, inquiring about the latest products and
options available for the 860 DSP, and requesting technical
assistance for your WorkBench software or 860 DSP units.

The information in the Online tab is updated periodically with
new options. Click on any of the links in the Online Tab to go to
the appropriate section of the 860 DSP Web site.

Option Description 

 

Right-clicking this option will display a menu to 
create a new connection to an 860 DSPr or to 
show offline 860 DSPr’s 

Double-clicking this option or selecting the plus (+) 
sign next to the 860 DSPr will display a list of the 
860 DSPr’s that are connected to WorkBench; 
double-clicking any of the 860 DSPr’s from this list 
will display a list of the Channel Plans associated 
with that 860 DSPr 

 

Right-clicking this option will display a menu to 
create a new connection to an 8300 FST or to 
show offline 8300 FSTs 

Double-clicking this option or selecting the plus (+) 
sign next to 8300 FST will display a list of the 8300 
FSTs that are connected to WorkBench; double-
clicking any of 8300 FSTs from this list will display 
a list of the Channel Plans associated with that 
8300 FST 
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General and Database Settings

To configure the general settings of the WorkBench software, perform the following steps;

1. The first time that the WorkBench software is started, the general settings need to be
configured. From the File menu, select Options, the Application Options Window
appears with the  tab displayed.

2. Enter general settings in the following fields:

Company Name: Enter the company name.

Address 1: Enter the first line of the
company address.

Address 2: Enter the second line of the
company address.

City: Enter the city.

State/Province: Enter the state or province.

Zip/Postal Code: Enter the zip or postal
code.

Country: Enter the country.

6. Configuring WorkBench
Chapter 6

The company name and address information are displayed on
the header of printed reports.

Asset ID: Enter the asset ID or security message you wish to be displayed on the 860
DSP splash screen during start up.

Asset ID Password: Enter a password to prevent unauthorized changes to the asset ID or
security message that is displayed on the 860 DSP screen.

Old Asset ID Password: When you wish to change your  Asset ID Password, enter the
new password in the Asset ID Password field and then enter the old password in this field
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Distance Units: Select the distance unit from the drop-down list. The options available to
select from are feet (ft) and meters (m).

Auto-Hide Navigator: Select this check box to hide the Navigator Window automatically
when you view data in the Data Window. When the Data Window is closed, the Navigator
Window is automatically displayed again.

Enable Online Web Content: Select this check box to enable the Online Tab in the
Navigator Window to display the information from the WorkBench Online Web site.

Enable Start-Up Animation: Select this check box to enable the start-up splash screen
animation.

Enable Start-Up Sound: Select this check box to enable the start-up sounds.

Enable TDM Component: Select this check box to enable the TDM Component (TDM
Component Required). For more information about the Trilithic Data Manager Component,
see Section VI: Trilithic Data Manager (TDM) Component.

3. When done configuring the general settings, select the Database Tab.

4. The  tab appears, enter database
settings in the following fields:

Type: Select the type of database. The default
database is set to the Microsoft Jet 4.0 database
engine (this database engine is used by Access
2000 and Access XP). The Microsoft Jet 3.5
database engine (used by Access 97), or
Microsoft SQL Server can also be selected.

The measurement unit selected in this field is used for
measurements throughout the WorkBench software. This
affects the various data wizards and the data logs.

Measurement Units: Select the measurement unit from the drop-down list. The options
available to select from are dBmV, dBuV, or dBm.
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Give consideration to where the data from TDM is stored. To
prevent the loss of data, consider storing this data on a
centralized server that is backed up regularly.

To facilitate the sorting and retrieval of saved data, consider
creating a separate database that contains only data from a
specific group of technicians or from a particular job function as
opposed to a single database for all records.

If using WorkBench with the TDM Component, the SQL Server
must be selected. The SQL Server will need to be purchased
separately and installed on the TDM server. Otherwise, simply
accept the defaults by selecting the OK button. The Jet 4.0 and
Jet 3.5 database engines are included with the WorkBench
software and need no additional configuration.

Use the Microsoft Windows Data Link Properties wizard to
make and verify a database connection by selecting the New
Connection... button.

If the selected database does not already exist, it will be created
and initialized after selecting the OK/Apply button.

The database holds the data gathered from the 860 DSPs,
configuration package information, and other data. The
WorkBench software sets up a default Jet 4.0 database when
installing the software. This database will be acceptable for
most installations without and further configurations.
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Server: This option is used only if the Microsoft SQL Server option is selected in the Type
field. Enter the name of the server on which the SQL Server database resides. The default
for this field is (local) for the computer on which the WorkBench software is installed.

Authentication: This option is used only if the Microsoft SQL Server option is selected in
the Type field. Select Windows NT/2000/XP Authentication to use the operating system’s
built-in user accounts, or Database Authentication to use SQL Server user authentication
when signing in to the server.

Username: This option is used only if the Microsoft SQL Server option is selected in the
Type field and Database Authentication is selected as the login method. Enter the
username for the server.

Password: This option is used only if the Microsoft SQL Server option is selected in the
Type field and Database Authentication is selected as the login method. Enter the
password for the server.

Set Current: Set the currently selected connection in the Previous Database Connections
list as the current database.

Remove: Remove the currently selected connection from the list. The will not delete the
database from disk.

New Connection...: Make and/or verify a database connection.

5. When done configuring the database settings, select the OK button.  WorkBench is now
configured.
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Overview

You may need to interact with Trilithic to do any of the following:

• Provide general feedback

• Submit a report on a problem

• Request a new feature or a change to an existing feature

• Get product support

You can submit feedback directly to Trilithic:

Trilithic, Inc.
9710 Park Davis Drive
Indianapolis, IN 46235 USA
(317) 895-3600 or (800) 344-2412
(317) 895-3613 (fax)
support@trilithic.com

You can also submit feedback or requests for product support through WorkBench.

Online Customer Feedback

To submit online feedback, do the following:

1. From the Help menu, select Submit Online
Problem Report or Comments.

7. Online Services
Chapter 7

The online customer feedback can also be displayed by
selecting the Trilithic logo  on the WorkBench toolbar.
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2. The Customer Feedback web page appears. Select the product to submit feedback on
WorkBench or 860 DSP and enter feedback information in the following fields:

OS: Enter the operating system that
WorkBench is running on.

Software Version: Enter the WorkBench
software version.

Product Key: Enter the product key that came
with this version of WorkBench. Enter
“unregistered” if no product key is available.
(Required field.)

First Name: Enter the user’s first name.
(Required field.)

Last Name: Enter the user’s last name.
(Required field.)

Postal / Zip Code: Enter the zip or postal
code. (Required field.)

Country: Select the country from the drop-
down list. (Required field.)

Address: Enter the company address.
(Required field.)

City: Enter the city. (Required field.)

State / Province: Select the state or province
from the drop-down list. (Required field.)

Telephone: Enter the phone number.
(Required field.)

Email Address: Enter your email address.
(Required field.)

Company: Enter your company name. (Required field.)

Job Title: Enter the user’s job title.

Comments: Enter your description of the problem or the change request.
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When submitting feedback, a reply will not be sent. Information
collected from WorkBench users is used by Trilithic to provide
continuous improvement to its products and services.

3. When done entering the feedback information, select the Submit button.  The user
information and comments are sent to Trilithic where they will be reviewed.

2. The Trilithic Online Support Forum
redirect web page opens in WorkBench.
The Trilithic Online Support Forum web
page will open in a separate Internet
browser window. If the separate web
page does not open, select the hyperlink
from the redirect web page in
WorkBench.

3. Select the WorkBench Technical Support Forum and review the existing posts for an
answer the WorkBench problem or create a new post that will be reviewed and answered
by a Trilithic moderator.

Online Support Request

To submit a support request, do the following:

1. From the Help menu, select Submit Online
Support Request.
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Device Firmware Upgrades

Trilithic periodically issues updates to 860 DSP, 860 DSPh, and 8300 FST firmware. These
updates are posted on the Firmware update page for downloading to the user’s computer.

To update the firmware:

1. From the Help menu, select Check for Updates.

2. The  appears WorkBench software
update web page opens. Follow the
instructions on the web page to update
the WorkBench software or perform a
firmware upgrade of the 860 DSP, 860
DSPh, and 8300 FST.

3. If you have not already done so, connect the 860 DSP(s) you want to update.

4. If more than one 860 DSP is connected, select one or more devices from the list shown on
the Devices tab.

5. From the 860 DSP menu, select Apply 860 DSP Upgrade. The standard File Open dialog
box appears.

6. Select the firmware patch you want to apply and click Open. (You can only apply a single
patch at a time, so if you have several patches to apply, you’ll need to apply them
individually.)

7. The WorkBench software downloads the firmware patch to the 860 DSP(s) you have
connected to the computer.

8. When the update process is complete, the 860 DSP(s) will reboot to apply the changes.
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